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  مفهوم ادارة المشروعات. 1

 مةالمقــد 1-1
ذلك باستخدام             ادئ إدارة المشروعات والطرق المستخدمة ل إن هذه الدورة تعطى مقدمة عن مب

ين ا      .وسوفت بروجكت تطبيقات برنامج ميكر   ين المشروع وب رق ب ي سوف یتعلم الطالب أن یف

روع       ية للمش ل الرئيس ة المراح دورة معرف ة ال د نهای دوره عن ون بمق وف یك رى وس ة أخ خدم

تخدام  ام باس ى إدارة المه ادرا عل ون ق ا .  MS Projectوسوف یك ي تعطيه إن المجالات الت

د        ام وتحدی دتها ،  الدورة تشمل ادخال معلومات المشروع ، إدارة المه ام التلخيصية   عمل  م  المه

اءو ع رب نش ة م ام الفرعي بعض  ط المه ام بعضها ب ة   . المه ارك آيفي تعلم المش وف ی ا س  آم

وارد  وحفظ المشروع الأساسي         تخصيص ذ            الم اء التنفي ع المشروع اثن داد      و تتب  وطباعة واع

 .التقاریر اللازمة اثناء التنفيذ 

 الأهداف 1-2
  :یكون لدیك القدرة علىفي نهایة هذه الدورة سوف 

 .فهم المبادئ الأساسية لإدارة المشروعات 

 .التعرف على بعض مصطلحات إدارة المشروعات 

 MS Projectمعرفة آيف یمكن الاستفادة من  

 MS Projectمعرفة عناصر ترآيب  

 MS Projectالسمات الأساسية لبرنامج تمييز  

 .القدرة علي عمل تخطيط متكامل اامشروع 

  سوف تتعلمماذا 1-3

 المقدمة لإدارة المشروعات 

 MS Projectالمقدمة لاستخدام  

 التخطيط للمشروعات 

 تكوین المشروع 

 تحدید علاقات المهام  

 موارد المشروع و تخصيص الإدارة 

 تخصيص تكاليف المشروع 

 التكلفة  و التحكم في مراقبة 

 تتبع المشروع أثناء التنفيذ 

 .طباعة وقراءة تقاریر المشروع 
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  مبادئ إدارة المشروعات 1-4
 المشروع ما  هو1-4-1

ده   ة وحي تج أو خدم اد من ت لإیج عي المؤقّ و الس روع ه لّ  . المش ا أن آ ت هن ة مؤق ي آلم و تعن

ة                    ة بطریق مشروع له بِدَایَة محدده و نهایة محدده و تعني آلمة وحيدة أنّ المنتج أو الخدمة مُختلف

  .متميزة عن آلّ المنتجات والخدمات الأخرى

ون  و  رف هيرس د ع ه  ) 1992(لق روع بأن ا   "المش ي له ام الت طة أو المه ن الأنش لة م أي سلس

ل          ه تموی ة محددتان و ل ة و نهای ه بدای أهداف محدده یجب أن تنجز ضمن مواصفات محدده و ل

ه       اموال   محدد و یستعمل المصادر المختلفة من      ان و      . و وقت و معدات و عمال د نسب بریم و لق

ه   ) 1990(ليش و تيرنر    الي   ) 1995(آخرین   تثمار صناعي     "تعریف المشروع بأن  وحدة اس

  ."جدیدة و التي لها بعض المعالم المميزة أو المتفردة و ذلك من خلال تناغم الوقت مع التكلفة

 صفات المشروع 1-4-2

 :یمكن تلخيص صفات المشروع بأنه

 له هدف یمكن قياسه 

 وقت محدد  

  محددةموارد 

 ها البعضمهام معتمدة على بعض 

 )دیناميكي(المشروع دائما في حالة تغيير  

  إدارة  المشروعات 1-5
 :إنها عملية تتكون من وظائف متنوعة هي

  التخطيط 

  التنظيم 

 المراقبة 

 التحكم 

 وذلك لكل من العناصر التالية

 الوقت 

 التكلفة 

  الجودة 

 الاداء 



 MS PROJECT                                                                                                                         إدارة المشروعات   

 7

 المراحل الأساسية للمشروع 1-6
المشروع إلى مهام یمكن قياسها ویمكن جدولتها وتشمل جميع المشاریع تشمل على تقسيم 

 الاتصال بين أعضاء الفریق وأیضا متابعة تقدم العمل 

 :هيجميع المشروعات تتكون من ثلاث مراحل رئيسية 

   التخطيط 

 تتبع وادارة التقدم 

 .انهاء المشروع 

 التخطيط : المرحلة الأولى 1-6-1
 :بيوتر والامساك بالقلم والورقة وذلك لتحدید الاتىإن افضل طریقة للتخطيط هي بإغلاق الكم

 .أهداف المشروع .1

 .ع ، توقعاتهم ، ومستوى التأثيروالمستفيدین من المشر .2

 .المهام المطلوب تنفيذها ، ویشمل ذلك الحصول على معلومات إضافية في حالة الطلب .3

 .الموارد المتوفرة .4

 )الموارد-  الميزانية– المواعيد المحددة (القيود  .5

 مثلث المشروع  :القيود 1-6-2
 ومجال تكاليفالوقت وال : (إن المشروع یتم تشكيله باستخدام عامل القيود والقيود المبدئية هي  

 )المشروع

  المشروعة آم من الوقت سوف یستغرق المشروع والذي سوف ینعكس على جدول:الوقت 

 مواردوارد من م تكاليف الآم من المال سوف یكلف المشروع وذلك اعتماداً على  :تكاليفال 

 .بشریة ومعدات ومواد

 .آم هو حجم العمل المطلوب لتلبية أهداف ومهام المشروع :المجال 

أن تعدیل أي عنصر من عناصر مثلث   .هذه العوامل الثلاثة معاً تسمى مثلث المشروع  

ى المشروع سوف یؤثر على العنصرین الآخرین وعادة ما یكون أحدهم له تأثير اآبر عل

 .مشروعك

 The Project Life Cycle  دورة حياه المشروع 1-7
" مورس"و الذي اقترحه لقد تبنى معهد إدارة المشروعات الأمریكية تقسيم دورة حياة المشروع 

"Morris"قسم المشروع الى أربعة مراحل هي حيث  والذي:-  

  " Feasibility“: مرحلة الجدوى -1
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رسمية ودراسات الجدوى والتصميمات الاستراتيجية وهي تشمل على وضع المشروع في صياغة 

  .ومرحلة الموافقات على آل ما سبق

  "Planning & Design“: مرحلة التخطيط والتصميم  -2

وتشمل على التصميم الأساسي وحساب آل من التكلفة وجدولة المشروع وصياغة بنود العقد 

  . وشروطه والخطط التفصيلية

        "Production Stage“ :مرحلة الإنتاج  -3

    .تتكون من التصنيع والتورید والأعمال المدینة والترآيبات والفحوصات

  "Turning Over: "الإنهاء  -4

آل هذه المراحل موضحة في  .وهي تشمل إنهاء الأعمال والتشغيل والفحص النهائي والصيانة

  .الشكل أدناه

 تعناصر ادارة المشروعا 1-8
 : التاليةتتكون ادارة المشروعات من العناصر

 الجدولة  

 الميزاینة  

 الموارد 

 متابعة التقدم 

 التقاریر 

  
  
  
  
  
  
  

  
  
  
  
  
  
  

  دورة حياة المشروع : 1-1الشكل 
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 Scheduling طرق جدولة المشروعات 1-8-1
 :هناك أنواع عدیدة من الجدولة الزمنية منها 

 .قائمه المشتریات 

 .القضبانمخطط  

 .القضبان المترابطمخطط  

 .المسار الحرج 

 . PERT یقة طر 

  .المحاآاة 

 مخطط القضبان 1-8-2
ة مخطط القضبان     Henry Gantt (1919-1861)قد قام هنري جانت ل  حيث  . بتطویر طریق

یَعْرِضُ مخطط القضبان أنشطة       .  لا زال مخطط القضبان یعرف آأفضل طریقة لتمثيل الخطط        

ا مع      جدولة أزمنة هذه الأنشطة و ذلك باستخدام القضبا      يةالمشروع و آيف   ن والتي یناسب طوله

ى                  . المدة الزمنية للأنشطة   دم و التي بَرْهَنت عل يط الأق و یعد مخطط القضبان أحد أدوات التَخْطِ

ة          . إنّه بسيط و واضح، و سهل الاستعمال و الَفْهَمُ        . آونها أداة مفيدة   يلة تخطيط و جدول و هو وس

دیث    ة و تح ي مراجع اج إل وُ  یحت ع   و ه كل واس رة بش ة بدمنتش ة  رج ن الأنظم ن أي م ل م اق

  .المعقدة

ال المشروع                   اهِمُ بإآم . النشَاط هو مهمّة أو عمل أو مجموعة مُرتبطة من المهامّ و الذي أَدَاؤه یُسَ

ز         واد  علاوة على تُخَصِّصُ  تواریخ لأنشطة المشروع،فان جدولة المشروعات تشمل تجهي و  الم

  . مشروع العمالة و المعدات اللازمة للمهامّ خلال وقت ال

یطلب العدید من الملاك تقدیم جدول زمني تفصيلي للمشروع یقدمه المقاول آوسيلة لمراقبة .

  .برنامج العمل

بان     و ط القض ة مخط تخفاف بقيم نُ الاس ه      ان . لا یُمْكِ ي قدرت ن ف وه تكم ر الق م عناص د أه أح

نُ لمخطط القضبان أن    . المشروعحالة السریعة و الواضحة على عرض و   لَ   یُو یُمْكِ تَعْمَلَ لتَنْقُ سْ

ا        عنصوره   ا یلبي حاجات الإدارة العُلي ام بم وارد    . وضع المشروع بشكل ع دما تكون الم وعن

وارد       فإن  . المطلوبة للمشروع محددة   ذه الم دئي له يم الاستعمال المب مخطط القضبان یستخدم لتقي

ين الأنشطة لا یمكن تمث                   روابط ب ات و ال ا يلو على الرغم من ذلك فان العلاق يّما      ه  بسهولة، لا س

ذا الغرض     بكات له ة الش تعمال جدول ث یفضل اس رة حي اریع الكبي ي المش ه. ف نإنّ عْب  م  الصَ

تَعْماَلَه                         ه من الصَعْب اُسْ ا إنّ ات و أیضً ين الفعالي ود ب ة و القي التعرف على تتبع العلاقات المنطقي
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ه       . دول بشكل عام  المُؤَثِّرات التي تَتَغَيَّرُ في الأنشطة علىُ  الج       بلتنبّؤ  ل لذلك فان مخطط القضبان ل

  .قدره محدودة آاداه للتحكم

 مخطط القضبان المترابط 1-8-3
ه بواسطة  ان ط فعاليات م رب رابط هو مخطط قضبان ت ةمخطط القضبان المت ات المنطقي  العلاق

ل    قد أَصْبَحَ معروفا آوسيلة ل     و. الّتي تَظْهَرُ اعتماد الفعاليات على بعضها بشكل منطقي        عمل تمثي

ى                        ا مباشرة عل ل الأنشطة و روابطه ه یسهل تمثي ى الحاسوب، حيث ان از  بياني منطقي عل جه

  .الكمبيوتر

ا   ليس فقط الأسهم التي تَرْبِطُ مخطط القضبان تُمَثِّلُ الربط المنطقي بين الفعاليات و لكنها  أیض

ي    له متابعة ان الترابط بين الأنشطة له فائده یمكن من خلا. تستخدم لربط المورد أخير ف اى  ت

  . و عمل المتابعة و التحكم المطلوبين عند تقدم العمل بالمشروعالفعاليات بسهولة

  )CPM(  طریقة المسار الحرج 1-8-4
يَأْخُذهُ                  ذي س طریقة المسار الحرج تحدد سلسلة الفعاليات في المشروع و التي تَتَحَكَّمُ في الزمن ال

ذه الطریقة بحساب الحد الادنى من الوقت اللازم للمشروع    تقوم ه).Hinze, 1998(المشروع 

  .من البِدَایَة الممكنة و تُنْهِي وفقا لأنشطة المشروع

المين  ين الع ارآة ب ار الحرج بالمش ة المس وَّرَتْ طریق  DuPont و Remington rand ( تَطَ

(Bedworth  .          ل ل    إن طریقة المسار الحرج و تقنيات الجدولة المُرتبطة بها، مث ورد و تحلي  الم

تحكم في المشروع و             يط و ال ة المستخدمة للتَخْطِ وى الأدوات التحليليّ ل أق الأسعار لا زالت تمث

  . الكمبيوترتقنيات في استخدام الأآثر على نحو واسع

 : هيCPMإن أقوى مميزات استخدام 

  .بين الأنشطةوَضِّحُ العلاقة المشترآة تُ آبيرا من الأنشطة، هي اأنها یمكن أن تمثل عدد •

  . التحكم في الانشطةتستعملانها مفيدة جدا لتوقع ما سيحدث و •

  .انها تحدد اآثر العناصر الحرجة في المشروع و تحدد اولویات التنفيذ المناسبة •

  و مخطط القضبان یساعد في تحدید المورد المطلوبة     CPMان الجمع بين استخدام   •

 .للمشروعَ  
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 Task Relationship ن المهامالعلاقات المنطقية بي. 2
یوضح 1-2 و الشكل هناك اربع انواع من العلاقات المنطقية و التي تربط المهام مع بعضها البعض

:و هيهذة العلاقات   

1. Finish to Start(FS) : تبدأ المهمة اللاحقة بعد نهایة المهمة السابقة مباشرة  

2. Start to Start(SS)   : بة المهمة السابقة مباشرةتبدأ المهمة اللاحقة مع بدا  

3. Finish to Finish(FF) : تنتهي المهمة اللاحقة مع  نهایة المهمة السابقة مباشرة  

4. Start to Finish (SF) : تبدأ المهمة السابقة مع نهایة المهمة اللاحقة مباشرة 

  

  العلاقات المنطقية بين المهام  : 1-2الشكل 
  

   لتوضيح نهایات و بدایات المهام  2-2 اي فعالية یستخدم الشكل و لتمثيل

  

  

  

  

  للمهامتمثيل البدایة المبكرة و المأخرة  : 2-2الشكل 

Lead/Lag Relationships 

 

 ES  DESC. EF 
 

 

   ES    DESC.     EF
 

FF ij

FS ij 

SS ij 
SF ij 

Forward Pass

Backward Pass

i Di j Dj

 

    LS  DESC. LF 
 

 

   LS    DESC.     LF
 

FF jk

FS jk

SS jk
SF jk

j Dj k Dk

E.F                                  E.S 
  

               النشاط
  

L.F                 D.          L.S.   

 النهایة المبكرة
 البدایة المبكرة

 النهایة المبأخرة البدایة المتأخرة
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E.F. = E.S. + D. 

L.F. = L.S + D. 

   (Total Float)  فترة السماح الكلية  2-1

  ة الكلية للمشروع الفترة الزمنية التى یسمح بها للنشاط ان یتأخر دون ان یؤثر على الفتر

Total Float ( T.F.) = L.F.(للمهمة )  – E.F.(للمهمة ) 

OR                  = L.S- E.S.  

اذا آانت قيمة فترة السماح الكلية اللمهمة الواحدة تساوي صفر فان المهمة تسمى مهمة حرجة 

ى مدة المشروع و هي تقع على المسار الحرج و اي تاخير او تغيير في مدة تنفيذها یؤثر عل

.آكل   

  (Free Float) فترة السماح الحرة  2-2

   الفترة الزمنية التراآمية للانشطة الغير حرجة للمشروع آله

Free Float (F.F) = E.S( اللاحقة  للمهمة ) – E.F( السابقة  للمهمة ). 

  حل مخطط الشبكات 2-3
  تمرین

  ع ایجاد المسار الحرج م2-3 آما هي موضحة في الشكل المطلوب حل الشبكة التالية

  

  

  شبكة تتابع المهام في المشروع:  3-2الشكل 
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  "Work Breakdown  Structure“  هيكل العمل المفصل  2-4

ل    ل المفص ل العم من       " WBS"ان هيك ك ض ي وذل روع الهيكل ب المش ن ترتي وراً ع ي تص یعط

ا آنتيجة لإنشاء المشروع وفي       مستویات یكون في المستوى الأعلى الخدمة  التي نری         د الوصل اليه

ة العمل       ا یوجد مهم ة  ”Task“ أدنى مستوى له ى     " Activity“او الفعالي يمها ال  والتي یمكن تقس

تقلة       ة                    أعمال محددة على مجموعات مس ذه الفعالي ة محددة له يم مالي .  و یمكن رصد وقت محدد و ق

وم المخط   ل المفصل ان یق ل العم اعدة  هيك ن بمس وب  ویمك ات المطل روع بتوضيح الفعالي ط للمش

تظم وشامل                    ؤأدا  .ها ضمن وقت واحد وما یتبعها في الوقت من ناحية الأداء وعلى التوالي بشكل من

اليف                   وارد والتك ة المشروع للم وم هيكل العمل      .  ویستخدم هيكل العمل المفصل لكل من جدول ویق

  .وتقدم العملالمفصل بتبسيط واختصار عملية التقاریر حول التكلفة 

ك         ددة وذل د مستویات متع ه عن ویتم إنشاء هيكل العمل المفصل تحت نظام عددي والذي یمكن تطبيق

  .لعمل هيكلية لكل من التكلفة وتخطيط الجدولة وعمل التقاریر

بكات وحصر    ة الش ؤوليات وجدول اج مصفوفة المس ل المفصل لانت ل العم تخدم هيك ن ان یس وبمك

  .ر وهيكل المنظمة وحصر أعمال التحكم في المشروعالتكاليف وتحليل المخاط

ة                           وارد اللازم ا حساب الم وائم توضح فيه ام فى ق يط المه إن هيكل العمل المفصل هو تنم

  .لإنهاء المهام والشكل التالي یوضح مثال لذلك

  

  هيكل العمل المفصل للمشروع

  

  

  

  

  

  

  

  

  

  

  هيكل العمل المفصل للمشروع  : 4-2الشكل 
  

الانشطة المدرسة اللامنهجية

منطقة خان یونس منطقة رفح

 مجموعة القدس مجموعة یافا مجموعة حيفا

رسم  آمبيوتر ریاضةآمبيوترریاضة رسم  رسمآمبيوترریاضة

1 المستوى

2 المستوى

3 المستوى

4 المستوى



 MS PROJECT                                                                                                                         إدارة المشروعات   

 14

  MS Project   بإستخداموتخطيط المشروعإدارة . 3

   MS Projectالبدایة مع  3-1

  في   بواسطة النقر المزدوج على الفأرة على الرمز المحدد MS Projectیمكن البدء بمشروع 

MS Project   مشروع من  أيأو بواسطة فتح MS Project 

 MS Projectاستكشاف واجهة  3-2
 له مميزات یمكن معرفتها من  MS Projectي فإن العاد  Windows إضافة إلى عناصر

ان . برامج الجداول الإلكترونية مثل الأعمدة والصفوف والمعادلة التي یستخدمها الصف للكتابة

المعلومات یتم إدخالها إلى الحقل المناسب آقاعدة بيانات وهناك أوامر متفردة ووسائل محددة 

  .اجهة الرئيسية یوضح الو1-3 و الشكل للعمل مع المشروعات

  

  واجهة ميكوسوفت بروجكت الرئيسية : 1-3الشكل             
 

 الأدواتقضيب  3-3
o  2-3 و هو موضح في الشكل يالأدوات القياسقضيب. 

o  لالأدوات المعدقضيب 

   

  شریط الادوات في ميكوسوفت بروجكت  : 2-3الشكل 
  

وات في تنفيذ الاوامر المختلفة و بشكل سریع من على سطح الشاشة یستخدم قضيب الاد

  .بإستخدام الفأرة
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  عرض وتغيير المناظر 3-4

 والتى تتكون من   MS Project  المتوفر فى  الرئيسية یمكن عرض العدید من المناظر

  Bar (GANTT) chart المهام و مددها (   یستخدم لعمل مدخلات المشروع الرئيسية

 )ةالزمني

 (CPM) Network یستخدم في عرض علاقات المهام مع بعضها البعض على شكل 

 .شبكة من المستطيلات

  Task usageیوضح ساعات العمل التي نفذتها الموارد من المهمة   

  Gantt trackingیظهر العمل المنجز في المسروع و نسبة الانجاز  . 

  Resource Graphیوضح تعارضات الموارد  . 

 Resource Usageیوضح استخدام الموارد المخصصة للمهام المختلفة  . 

 Resource Sheetیوضح الموارد المتاحة للمشروع  .  

  .3-3و هناك العدید من المناظر الاضافية التي تظهر في الشكل 

  

  مناظر اضافية في ميكوسوفت بروجكت  : 3-3الشكل         
  

 تغيير المناظر 3-5
 . یمكن اختيار المنظر المناسب على الشاشة الرئيسية قائمة الى اليسارمن ال

  . مناظر اضافيةالحصول على     View > More views  یمكن من الأمر    •

  Tables الجداول 3-6
لكل منظر فى ميكروسوف بروجكت هناك قوائم مختلفة والتى تقوم بتعریف المعلومات 

بالنظر الى قائمة الجدولة فانك سوف تلاحظ تاریخ فمثلا   .حسب التوصيف الخاص بها 

 والقائمة المتاحة على ميكروسوف بروجكت هي قائمة الإدخال   .بدایة ونهایة اى مهمة
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Entry Table  حيث سيكون بإمكانك إدخال المعلومات عن المهام وحتى یمكن تغيير

  -:القائمة فإن یجب عمل التالي

  .الادوات من شریط Viewأنقر على قائمة . 1

   .Tablesأختر من القائمة . 2

  . مثلا (Cost )  نوع الادخال المطلوب Tablesمن قائمة . 3

 GANTT Chartمنظر  3-7
 الرئيسي المعروض والمتاح دائماً نظرهو الم (GANTT Chart) إن منظر مخطط المستقيمات 

 .لمشروعفي اعلومات إدخال وتعدیل الم  الذي یمكنك منهنظرعلى ميكروسوفت بروجكت وهو الم

  . مخطط المستقيمات اتبع الآتينظروعند عرضك لم

  .GANTTأختر من القائمة منظر  .1

 . الرئيسيةGANTTسوف یظهر لدیك عناصر منظر  .2

  معلومات المشروع 3-8
  فتح متف جدید 3-8-1

  New  اختر فتح ماف جدید Fileمن قائمة . 1

  Blank projectمن المربع الحواري الذي یظهر اختر . 2

 إدخال بيانات المشروع الأولية 3-8-2

 للوصول إلى start dateإن أول خطوة في إدارة المشروع هي تحدید تاریخ بدایة المشروع 

  :قائمة إدخال البيانات التمهيدیة اتبع الآتي

  Project Information  اختر  Projectمن الفائمة . 1

 .Start date لمشروع من المربع الحواري قم بإدخال تاریخ بدایة ا. 2

  

      ونهایة المشروعأبدایة مات  معلو :4-3الشكل           
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   وحالة المشروع ونهایة المشروعأإدخال بدایة  یمكن 4-3 في الشكل ع الحواري بالمرمن 

 . ضمن مشاریع الشرآة الاخرىیة للمشروعووالأول

 تحذیر
فقط یمكنك إدخال إما بدایة المشروع وهو   . روع معاًلا یمكن إدخال بدایة ونهایة المش

، أما إذا آانت نهایة المشروع هي الأهم وهناك قيد لإنهاء المشروع قبل (Forward pass)الشائع

 و یكون التخطيط في هذة الحالة من الخلف الى الامام و .موعد محدد فيمكن إدخال نهایة المشروع

    (Backward pass)یسمى 

 Priorityلویة العمل ضمن المشروع  أو 3-8-3
یقوم ميكروسوفت بروجكت بإدخال أولویة المشروع بين عدة مشاریع لإیجاد التوازن في استخدام 

 تعطي لأعلى 1000 فقيمة 1000إلى    0.0 الأولویة بقيمة تقدر من  تقاس  .الموارد المشترآة

  .أولویة

  نتائج إحصائية 3-8-4
 في مربع Statisticحصائية عن المشروع إذا تم اختيار مربع  یمكن الحصول على معلومات إ

  Project Informationمعلومات المشروع 

  تسجيل صفات المشروع  3-9
یمكن تسجيل العدید من صفات المشروع الثابتة و التي تمثل اداه تعریف المشروع حيث یتم 

 مدیر المشروع و اسم استخدام هذه الصفات ضمن مخرجات المشروع مثل اسم المشروع و اسم

  :الشرآة و خلافة و لعمل ذلك اتبع الاتي

  Properties أختر Fileمن قائمة  .1

 و اضف المعلومات المناسبة Summaryإختر شاشة  .2

  OKانقر موافق  .3
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  إدخال المهام والمدة الزمنية. 4
   ادخال المهام4-1

 ةع المؤشر على سطر مهمقط ض، فعند بدایة أي مشروع جدید فإنك تكون جاهزاً لإدخال المهام

  . وابدأ بعملية الطباعةةجدید

   Durationللتحرك إلى عمود المدة الزمنية  Tab    المفتاحاستخدام

  . للتحرك بين الاسطر لادخال مهام جدیدةEnterاستخدم المفتاح 

ة فإن إذا لم تدخل أي مد  .بإمكانك إدخال المدة الزمنية بالساعة أو باليوم أو بالشهر أو الأسبوع

 .یوماً واحداً المده الزمنية ميكروسوفت بروجكت یحتسب

بعد إدخالك المهام والمدة الزمنية سوف یعرض لك ميكروسوفت بروجكت هذه المعلومات ممثلة 

  .بيانياً في مخطط جانت إلى اليمين

  تمرین

 في الشكل و التي تظهر Water pipe lineالمطلوب ادخال الفعاليات التالية في ملف جدید بعنوان 

4-1.  

 

   توصيل خط مياةمشروع فعاليات  :1-4الشكل 
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   المدد الزمنية للمهام4-2

  یمكن ادخال المدة الزمنية للمهام بواحد من ثلاث طرق

 Taskبالنقر المزدوج على الزر الایسر للفأرة على اسم الفعالة یظهر المربع الحواري . 1

Information ادخال المدة الزمنية   حيث یمكن Duration  یوضح مربع معلومات 2-4و الشكل 

  .المهمة

  . الحواريGANTTیمكن ادخال المدة الزمنية مباشرة من مربع . 2

  .یمكن زیادة مدة الفعالية مباشرة من القضيب جهة اليمين. 3

  

 

  المهمةمات  مربع حوار معلو :2-4الشكل 

    
  شاط بين أنشطة اخرى إدراج  ن 4-3

 .نحدد النشاط المطلوب إدراج الأنشطة الجدیده قبله 

 .من لوحة المفاتيح Insert نضغط زر  

تلقائيا   (FS)  نكتب أسماء المهام الجدیدة حيث یتم ربط النشاط المدرج الجدید بعلاقة  

 .مع الأنشطة الأخرى
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  ضبط تقویم المشروع. 5

 حدید أیام العمل والإجازات ت5-1
عند بدایة أي مشروع یجب تحدید عدد ساعات العمل اليومية وعدد ساعات العمل الأسبوعية وأیام 

 .العطل وموعد بدایة الأسبوع وأیام الإجازات المتكررة والغير متكررة أثناء فترة المشروع

  ولعمل ذلك یتم فتح المربع الحواري التالي

 تعدیل خيارات التقویم .1

  Change Working Timeمر  اختر الاToolsمن القائمة  

 Calendar في المربع المفتوح حيث یتم فتح صفحة التبویب Optionsانقر على زر  

  یتم اختيار یوم السبت آبدایة للاسبوع 

  یتم تعدیل بدأ ساعات العمل للمشروع حسب نظام المؤسسة 

  اختيار یوم مخصص بعطلة .2

  Change Working Time اختر الامر Toolsمن القائمة  

  اليوم او الایام التى ستكون ایام اعطال ضمن فترة المشروعحدد  

  علم هذه الایام بالفأرة 

  Non working time  قم یتغيير صفة هذة الایام بأختيار  

  :  عمل الاتيChange Working Time  و یمكن مباشرة من المربع الحواري 

تيار یومي السبت والأحد ثم من هذا المربع یتم تحویل بدایة العمل إلى یوم السبت حيث یتم اخ 

وبذلك یتحول یومي السبت والأحد من أیام  (Non default working time)          نختار 

 .عطل إلى عمل

م الجمعة إلى ووبذلك یتحول ی (Non working time)   ثم یتم اختيار یوم الجمعة مع الأمر  

 .عطلة

  .ویم المشروع یوضح المربع الحواري الخاص بتغيير تق1-5و الشكل 



 MS PROJECT                                                                                                                         إدارة المشروعات   

 21

 

  تقویم المشروعبمربع حواري خاص : 1-5الشكل                 
  

  Copy and Paste نسخ المهام ولصقها  5-2
ص قلسهوله تنفيذ وإدخال المهام إذا تكرر بعض المهام یمكن القيام بعمل نسخه منها أو 

  -:ولصق المهام فى مكان جدید وذلك باتباع الآتي 

  الخلية ID بوضع المؤشر على رقم تعریف یتم اختيار الخلایا 

 Editمن قائمة  Copy  نختار أمر   

 .نحدد  خلایا فارغه یتم اللصق إليها  

  Editمن قائمه   Paste  ثم نستخدم الأمر  

 Editمن قائمة    Cutإذا آان المطلوب قص یتم اختيار أمر  

  Pasteنكرر أمر  

    Deleteمسح المهام  5-3

 ID بانقر على رقم تعریف الخلية لمسح مهمة أو مجموعه من المهام یتم تحدیدها بواسطة المؤشر

   Deleteیتم اختيار الأمر   Edit   ثم من قائمه

  Summary Tasks المهام التلخيصية 5-4
 یوضح شكل المهام 2-5 و الشكل  تحت مهام تلخيصيةالمهامیتم جمع مجموعة من 

جموعة المهام تشترك مع بعضها فى صفات معينه وتكون مده المهام وتكون مالتلخيصية 

ت المجموعة حالتلخيصية هو الفرق بين تاریخ بدایة ونهایة مجموعة المهام المنضویة ت

 .التلخيصية 

 -:یتم إنشاء ذلك حسب الخطوات التالية
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 .مهامإدراج النشاط التجميعي آعنوان لمجموعه  

 .ابعة لها بتعليمها بالمؤشر الفرعية التالمهامیتم تحدید  

   Indentثم نختار أمر   Outline یتم اختيار   Project  من قائمة  

 .يوبذلك نحصل على النشاط التلخيص 

  

  شكل المهام التلخيصية: 2-5الشكل 
  

 ملاحظة

 .یمكن ربط المهام التلخيصية مع بعضها البعض او مع اي خلایا منضویة تحتها 

  من شریط الادوات  Unlinkلة الربطة بين خليتين نختار هذه الخلایا و نختار الامر لازا 

  الرئبسي

  لمسح الخلایا المرتبطه بها Deleteلا تحاول ازالة الروابط بواسطة استخدام الامر  

Predecessorsو هذا سوف یؤدي الى مسح المهمة بالكامل و ليس الرابطة وحدها .  

 لخيصيةإلغاء المهام الت 5-5
 .حدد المهام المتفرعة عن المهمه التلخيصية  

   Out dentثم نختار   outline  نختار   Project   من قائمه  

  .تقوم بمسح المهام التلخيصية من قائمة المشروع  

  حجار الزاویةأ 5-6

نهایة المرحلة الاولى للمشروع او  هي عبارة عن مهام عمل لها اهمية خاصة في المشروع مثل

تم ادراج احجار الزاویة بمدة  ی او موعد اخذ موافقات من الاستشاري و مهمةعد تورید موادمو

  .زمنية تساوى صفر

  ةاضافة ملاحظات على المهم 5-7
    .Task Information اختر الامر Projectمن القائمة  

   .Task notesمن المربع الحواري أختر الواجهة  
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  .ارةاضف اي ملاحظات خاصة بالمهمة المخت 

  Linking Tasksربط المهام  5-8
إن ربط المهام بعضها ببعض یتطلب تفهم العلاقات المباشرة بين المهام المختلفة وقد سبق الحدیث 

حيث  (FS, FF, SS, SF) عن أربع علاقات منطقية لربط المهام مع بعضها البعض وهى   

  .تستخدم هذه العلاقات لربط المهام مع بعضها البعض

إن هذه المرحلة من أدق وأهم مراحل التخطيط للمشروع وربط الفعاليات مع بعضها یعنى تشكيل 

 .المسار الحرج للمشروع وذلك بتحدید أقصر مدة یمكن إنجاز المشروع فيها 

لذلك تسمى الفعالية التى یتم إنجازها   .یعتمد آثير من الفعاليات فى بدایتها على نهایة فعاليه أخرى 

 .(Successor)، والتى تلى فى الإنجاز تسمى اللاحقة  (Predecessor)ها السابقة أولا بأن

یمكن ربط المهام باستخدام وسائل متعددة وأسهل طریقة هى بتعليم الفعاليتين المطلوب ربطهما 

 .بواسطة المؤشر ثم الضغط على أداه ربط المهام فى شریط الأدوات

 Task Information Boxیمكن أیضا باستخدام 

  : وذلك باتباع الخطوات الأتية

 و Predecessor   یراد ربطها مع مهمة سابقة التيSuccessor فعل المهمة التالية  

     .Task Information Toolاختر من شریط الادوات 

   .Predecessor اختر التبویب  

 .علم السهم ثم اختر من القائة نوع الربط المطلوب 

 و الخاص بربط Predecessor حواري الخاص بتبویب یوضح المربع ال3-5و الشكل 

 المهام 

  ربط مجموعة من المهام مرة واحد 

  مع الاسهم Control او Shift علم مجموعة المهام بالؤشر او باستخدام 

  .من القائمة الرئيسية Link task  اختر 

 بين في حال الرغبة بتغيير نوع العلاقة . FSیقوم البرنامج بربط المهام بالعلاقة  

  .مهمتين استخدم الطریقة التالية

   



 MS PROJECT                                                                                                                         إدارة المشروعات   

 24

  

   و الخاص بربط المهام Predecessor  مربع حواري تبویب: 3-5الشكل 
  

  Change Relationshipsتغيير العلاقات بين المهام المترابطة  5-9

 (FS) مج وهى للبرناالافترضية یتم على العلاقة   Link Task   إن ربط الأنشطة من خلال أمر 

 .ولذلك یمكن تغيير نوع العلاقة بعد ذلك باتباع إحدى طریقتين   

 .بواسطة المؤشر العملية اللاحقة التى یراد تغيير علاقتها مع المهمة السابقة اختر  

او بواسطة النقر المزدوج على    Task Information اختر  Project  من أمر  

من    Predecessor   حيث یتم اختيار قائمة الخلية یظهر المربع الحواري التالى

 . یوضح  ربط المهام مع بعضها البعض4-5الشكل   و.Type عامود

   Lagیمكن تغيير نوع العلاقة المطلوبة ویمكن تحدید قيمه واشاره  

 الطریقة الثانية

 حيث یمكن تغيير  النقر المزدوج على الخط الرابط بين الفعالتين یظهر المربع الحواري 

  Lagنوع العلاقة  وقيمه 

 

 ربط المهام مع بعضها البعض : 4-5الشكل 
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    Recurring taskالمهام المتكررة   5-10
 فان ،ن تحدث آل یومين أو آل أسبوع وهكذاأعند تكرار  مهمه ما فى المشروع بشكل منتظم آ

 یوضح المربع الحواري الخاص 5-5 و الشكل .البرنامج یعطى المجال لتكرار مثل هذه المهام 

  .بتكرار المهام على فترات منتظمة

  Recurring taskنختار     Insert  من قائمه   

  .والمده الزمنية بالاضافه الى طریقة تكرار المهمة  Task name  سم إیتم تحدید   

                                                                            

  

                                                                                          

 

 

 

 

 

  

  

  المربع الحواري الخاص بتكرار المهام على فترات منتظمة : 5-5الشكل          
  
  

  Task Constraints القيد على استخدام المهام 5-11
داخل ميكروسوفت بروجكت أن هذه المهمه یتم لافتراضي اعند استعمال أى مهمه یكون الأمر 

أما . وذلك إذا تم جدولة المهام لتبدأ في اقرب وقت ممكن   As soon As possible  ,  تنفيذها

  فإن الجدولة Project Informationعندما یتم تحدید نهایة المشروع عند بدأ الجدولة في مربع 

 و آل ذلك مرتبط بتاریخ بدأ As Late As Possibleير ممكن تتم بحيث تبدأ المهمة عند أآبر تأخ

 هو القيد الوحيد الذى یمكن فرضه على تنفيذ أى مهمة بل اولكن ليس هذ. أو نهایة المهمة السابقة

وتبقى مهمه  .هناك العدید من الصيغ التى تحمل معانى مختلفه وتحمل قيود محدده على تنفيذ المهام

  .القيود التى سيفرضها على تنفيذ مهمه ماالمخطط فى أن یحدد نوع 

 أنواع القيود 5-11-1
  :هنك نوعين من القيود و هي

   .Flexible Constraintsالقيود المرنة  5-11-2
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تسمح للبرنامج ان یحسب الجدولة و ان یقوم بضبطها و تعدیلها بشكل مناسب بناء على القيود وهي 

  .  المفروضة

   .Inflexible Constraints القيود غير المرنة 5-11-3

و القيود غير . و هي التي تحدد الجدولة لانها تتطلب ان تبدأ المهمة او تنتهي ضمن شروط محددة

المرنة تطبق عندما یكون هناك ضرورة مطلقة و قد یؤدي تطبيقها الى فرض العدید من التضاربات 

 و الذي یظهر فئات Advanced یوضح المربع الحواري للتبویب 6-5 والشكل .عند تنفيذ المهام

  .القيود المختلفة داخل البرنامج

  اوامر القيود المرنة 5-11-4
As soon as possible   بحيث  و هو الخيار الافتراضي عندما تحدد تاریخ بدأ المشروع 

تبدأ المهمة بأقرب وقت ممكن و ذلك بمراعاة الروابط الاخرى 

  .للمهمة

As late as possible   الافتراضي عندما تحدد تاریخ نهایة المشروع بحيث  و هوالخيار 

تبدأ المهمة مع اآبر تأخير ممكن و ذلك بمراعاة الروابط الاخرى 

  .للمهمة

Finish No Earlier Than یجب ان لا تنتهي المهمة قبل تاریخ القيد المحدد    

Start  No Earlier Than  یجب ان لا تبدأ المهمة قبل تاریخ القيد المحدد   

    

   

   و الذي یظهر فئات القيود المختلفةAdvancedالمربع الحواري للتبویب  :  6-5الشكل 
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   اوامر القيود غير المرنة5-11-5
  

Must Start on    یجب ان تبدأ المهمة في التاریخ المحدد.  

Must Finish on    یجب ان تنتهي المهمة في التاریخ المحدد    

Finish No Later Than  یجب ان تنتهي المهمة قبل تاریخ القيد المحدد    

Start  No Later Than     یجب ان تبدأ المهمة في او قبل التاریخ القيد المحدد   

  ضافه قيود على أى مهمة إ5-11-6
  Task informationانقر نقرة مزدوجة على خلية المهمة لفتح المربع الحواري  

  Advancedانقر على صفحة التبویب  

   .Constraint Typesأنقر على سهم القائمة  

  OK تم اآد الاختيارConstraint Dateأختر القيد المناسب و اختر تاریخ بدأ القيد من  

   ازالة القيود5-11-7
  حدد المهمة المراد ازالة القيد عنها 

 ثم انقر على صفحة التبویب Task Information الامر Projectإختر من القائمة  

Advanced.   

   .OK  ثم انقر As soon As possible الامر Constraint Typeإختر من قائمة  

 .  تكون قد ازلت القيد غير المرن عن المهمةAs soon As possible بإختيار الامر 

   Setting Deadlineضبط تاریخ الانجاز الاخير للعمل 

مهمة ما و الذي یجب ان بدلا من فرض قيد غير مرن یمكن تسجيل موعد الانجاز الاخير ل

 لن یغير من تاریخ الجدولة Deadlineو وضع . لا تتأخر بعده و لكن یمكن ان تنجز قبلة

 و لم تنتهي المهمة بعد فان البرنامج یعرض Deadlineو اذا تم تجاوز تاریخ . المفترض

  . بواسطة سهم نحو الاسفل للدلالة على ذلكIndicatorمؤشر في العمود 

   Time scale قياس الزمن تغيير م5-12

  وذلك باستخدام  GANTT Chart   یمكن التحكم فى مقياس الزمن فى لوحه

   Time scale اختر الأمر  Format   من القائمة 

 GANTT Chart تغيير طریقه عرض  5-13

 :یتم تغيير طریق إخراج وعرض مخطط القضبان باستخدام الأمر التالى

حيث یتم اختيار     Gantt chart wizard لأمراختر ا   Format من القائمة  

  .ترغبها المحددات التى
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 اظهار خط المسار الحرج 5-13

     Gantt chart wizard اختر الأمر   Format من القائمة  

   .Step 3 من critical bathاختر الامر  

   لامرللتأآد من تنفيذ ا Format تنفيذ الامر الاخيراآمل باقي الخيارات و تأآد من  

     
  عرض مخطط المستقيماتیحدد اختيارات المربع الحواري  و الذي  :  7-5الشكل 
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Project 1 

Project description: 

The table 1 indicating the tasks of the project, duration and its relations and 

constraint   

 

Conditions 

Starting date of the project is 10/10/03 

The time period is 5 days. 

  

Required: 

Establish a Bar chart diagram. 

Establish logical relation ships 

  

Table 1 

DurationType of relationDepends on ActivityNo. 

1 day---- ---- Introduction1

1 dayFSIntroductionMS project2 

1day FS MS projectData entry3

2dayFS

SS

MS project

Data entry

Logical 

relations

4

1 dayFFLogical 

relations

Constraints5

1 dayFS ConstraintsImprovement6
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  Resources Management أدارة الموارد. 6
  انواع الموارد 6-1

 -:ویوجد هناك نوعان من الموارد   .ص والمواد والمعدات ان موارد المشروع تتكون من الأشخا

  Work Resourcesموارد عمل  •

 و یمكن تحدید الأشخاص  . المحددین لتنفيذ مهمة ما و المعداتوموارد العمل تشير الى الأشخاص

 .بواسطة أسمائهم أو بواسطة الوظيفة التى یشغلوها 

   Material Resources یةموارد  ماد •

 تشير الى المواد التى سوف یستهلكها المشروع أثناء فتره التنفيذ اضافه الى اسم ادیةلمموارد اال

 .المورد فانه یلزمك معرفة الكميه التى یتوفر بها وتكاليف هذه الموارد

 .ساعة الأسبوعية على مهمة محدودة  40 من %10 فمثلا قد یلزم أحد الموارد ليعمل فقط 

 .ع على مده المشروع آكل وسوف تؤثر هذه النسبة بالطب 

ویمكن خلال البرنامج تجهيز قائمه موارد والاختيار من ضمن هذه القائمة وتعيين الموارد الخاصة 

  .لبغض المهام أو لكل المهام

 إدخال معلومات الموارد 6-2

  :ة طرقدیمكن ادخال معلومات الموارد بع

 حوار تكليف الموارد  في مربعE-mailإضافة عناوین من دفتر البرید الالكتروني  •

Assign Resource.   

   .Resource Sheetاضافة الموارد مباشرة في جدول من صفحة الموارد  •

 Resourceإضافة معلومات مفصلة باستخدام مربع حوار معلومات الموارد  •

Information.   

   .Resource Formإدخال المورد في نموذج  •

 تعيين موارد لمهام  6-3

 شرإختر المهمة بالمؤ 

  Task Information الامر Projectإختر من  

  Advancedإختر التبویب  

 أآتب اسم المورد وعدد الوحدات المتوفرة  

 . في لوحة المفاتيح للانتقال الي الحقل التالي(Tab)إضغط على المفتاح  

  

   Resource sheetقائمة الموارد   6-4
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 وذلك من أمر   Resource sheet وار فى ملف خاص یسمى میمكن عمل قائمة  

View.   

  .View من القائمة Resource sheetاختر الامر  

  .اضف معلومات المورد المطلوبة 

  معلومات الموردو الجدول التالي یوضح المعاني المختلفة ل
            

Resource Name   أسم المورد.  

Type       عمل او مادي (نوع المورد(.  

Material label     عدد، آجم،طن(اديوحدة قياس المورد الم(...  

Initial       بادئة اسم المورد.  

Group    اذا تشابهت الموارد في الصفات توضع ضمن

  ...)مبرمجين، مدرسين،(مجموعة

Max Units   النسبة المئویة القصوي المتوفرة من المورد و قد تكتب على

  شكل عدد

Std. Rate    100$(الكلفة في وحدة الزمن/d و  دولار في اليوم100 غي 

  )هكذا

Ovt. Rate       الكلفة في وحدة الزمن المدفوعة للعمل الاضافي  

Cost/Use   اي معدل الزمن . الكلفة للمواد تضاف و ذلك حال استخامها لمرة 

  .یقاس بالمرة

Accrue At    توضح متى یستحق دفع المورد و هناك ثلاث خيارات عند بدایة

 او یتم End  او عند نهایة عمل المورد Srartعمل المورد 

    Prorated الدفع بالتناسب مع استخدام المورد

Base Calendar    وهو نوع التقویم و یوجد ثلاث انواع من التقویم.  

Code   و یمكن ادخال اي رمز مالي یتم احتساب المورد عليه.  
  معلومات المورد  6-5

  یمكن اضافة معلومات اخرى عن المورد

 في مربع حواري Resource Nameرد انقر نقرة مزدوجة على اسم المو 

Resource Sheet یظهر مربع Resource Information.   

  ..قم بإدخال اي معلومات متوفرة عن المورد 
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 و ادخال قائمة التكاليف حال و جود تغيير في تكاليف Working Timeیمكن ادخال  

   .Costالمورد مع الزمن 

    Workgroup تعریف مجموعات العمل 6-6

   workgroup العنوان Resource Informationفي المربع الحواري اختر  

  یوجد ثلاث خيارات تمنحك امكانية التواصل مع المورد و هي

 Default    

 None    

 E-mail    

 Web    

نامج تلقائيا باسناد نوع مجموعة العمل الى آل مورد و نوع مجموعة العمل الافتراضي ریقوم الب

 Emailهو 

   Assign Resources ردتخصيص الموا  6-7

  :یتم تخصيص مورد ما لمهمه عمل آما یلى

  .حدد المهمة التي ترید اضافة مورد لها 

 .  Assign Resources اختر ثم  Resources   اختر  Tools   ائمهقال من 

 . تحتاجیمكن تخصيص أى عدد من الموارد للمهمة حسب ما 

  .لقائمة فيظهر سهم اResource Nameیتم وضع المؤشر على  

  .اضغط على السهم تظهر قائمة الموارد المتوفرة 

  .اختر اسم المورد من القائمة 

  .اضف بعد ذلك عدد الوحدات من هذا المورد المطلوبة لاداء هذة المهمة 

  .لاضافة مورد اخر للمهمة آرر ما سبق 

 .لا یمكن اضافة موردین في عملية واحده 

 Resourcesت المهام و صفحة تبویب  یوضح المربع الحواري لمعلوما1-6و الشكل 

  .حيث یتم ادخال و تخصيص الموارد
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.  

  .تخصيص المواردل Resourcesمربع معلومات المهام و صفحة تبویب : 1-6الشكل 
  

  فهم عمل الموارد  6-8

  : هيعند ادخال اي مورد فان البرنامج یتعامل مع ثلاث  عوامل

  Duration (D)الفترة الزمنية 

  Units (U)الوحدات 

  Work (W)) العمل( الجهد 

  :ة الجهد آما یليمو یقوم البرنامج بحساب قي

Work = Duration * Units  

  :مثال

نفرض وجود مهمة عمل یستغرق اداؤها خمسة ایام عمل و قد تم تخصيص ثلاث موارد لها ، آل 

 ساعات 8ل القياسية وهي بفرض استخدام ساعات العم. من الوحدات% 100مورد مخصص بقيمة 

  : تحسب آما یلي Wفي اليوم ، فإن قيمة الجهد 

Work = 5*8*3 = 120 hrs. 

و بالاختيار بين .  لهذة الفعالية فان البرنمج سوف یقوم باعادة الجدولةخرفي حالة اضافة اي موارد ا

 الفترة الزمنية آاول تعدیل الفترة الزمنية و الوحدة و الجهد فان البرنامج مبني علي اختيار تغيير

نامج سوف یختار تغيير الجهد ر فان الب Fixedو لكن عند عمل الفترة الزمنية لتكون ثابتة . اختيار

   Task Typeو هكذا یمكن التحكم في اختيارات البرنامج و ذلك مع تعریف . ثابتة الوحدةو تبقى

 Task Type العمل مهمة نوع 9 -6
  Fixed Units with Effort Driven قادة بالجهد   مهمة ذات وحدات ثابتة م6-9-1
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 .إذا اضفت وحدات موارد ، یعيد البرنامج حساب المدة 

 .إذا غيرت النسبة المئویة  لتكليف المورد ، یعيد البرنامج حساب المدة 

 .إذا غيرت المدة،  یعيد البرنامج حساب آمية العمل 

 .ةإذا غيرت آمية العمل ،  یعيد البرنامج حساب المد 

 .یمكن تقصير مدة مهمة اثناء التنفيذ باضافة وحدات للمهمة 

  Fixed Duration مهمة ذات مدة ثابتة 6-9-2

 .  اذا اضفت او حذفت وحدات ، یعيد البرنامج حساب العمل 

 .إذا غيرت النسبة المئویة للوحدات ، یعيد البرنامج حساب آمية العمل 

 .اب آمية العملإذا قمت بزیادة المدة ،  یعيد البرنامج حس 

 .إذا غيرت آمية العمل ،  یعيد البرنامج حساب الوحدات 

   Fixed Duration with Effort Driven مهمة ذات مدة ثابتة مقادة بالجهد 6-9-3

 .  اذا اضفت او حذفت وحدات ، یعيد البرنامج حساب الوحدات 

 .لإذا غيرت النسبة المئویة للوحدات ، یعيد البرنامج حساب آمية العم 

 .إذا قمت بزیادة المدة ،  یعيد البرنامج حساب آمية الوحدات 

 .إذا غيرت آمية العمل ،  یعيد البرنامج حساب الوحدات 

   تحدید النوع الافتراضي للمهمة 6-9-4

  .Schedule ثم انقر على صفحة التبویب Option الامر Toolsإختر من القائمة  

  .Default Task Typeاختر من القائمة  

 . لتطبيق التغييرOKقر على زر ان 

سوف یصبح النوع الذي اخترتة هو نوع المهام الجدیدة بعد الاختيار و لكنه لا یغيير  

 .خصائص او نوع المهام التي سبق تخصيصها

  المواردةادار 6-10

ان اداره الموارد تعنى تحدید مده عمل المورد ومواعيد استخدامها اضافه الى إمكانية تغيير سعر 

   :ورد أثناء فتره التنفيذ والخطوة الأولى هىالم

   Resource usageنختار   view من قائمة  

 -:من المربع الحوارى هذا یمكن عمل الأتى 

 تحدید تاریخ عمل المورد 6-11
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نقوم بالنقر المزدوج على اسم المرد    Resource usage   الخاص بيع الحواربمن المر

 Assignment  لعمل به  فيظهر المربع الحوارى المسمى  المراد تحدید موعد أو تاریخ ا

Information  رد أو موعد نهایة استخدامه وحيث یتم تحدید موعد بدأ استخدام الم. 

 دراسة تدرج سعر المورد 6-12

فى حاله التخطيط للمشروع وآان هناك توقعات أن أسعار استخدام بعض الموارد سوف یتغير 

 .البرنامج یتيح لك أن تسجل أآثر من معدل لسعر المورد خلال تلك الفترةخلال فتره التنفيذ فان 

  .Resource Usage  الخاص يفى نفس المربع الحوار 

 Resourceیتم النقر المزدوج على اسم المورد فيظهر المربع الحوارى    

Information.  

 ,A, Bلأحرف  ر مرتبه حسب ااحيث یوجد بها خمس قوائم أسع  Cost یتم اختيار قائمه 

C,  D, E  تضم القائمه A   السعر القياسى الذى تم إدخاله فىResource Sheet  . و

 حيث یتم costs یوضح المربع الحواري لمعلومات المورد و صفحة تبویب 2-6الشكل 

  .ادخال و تخصيص التكاليف

  

 .وتواریخ استخدام هذه الأسعار   B یتم إدخال أسعار جدیده فى القائمة  

م تخصيص السعر الجدید للمهمة المطلوبة وذلك بالنقر المزدوج على اسم المهمة یت 

  Assignment Information فتظهر القائمة

  

  .تخصيص التكاليفل حيث costsمربع  معلومات المورد و صفحة تبویب : 2-6الشكل 
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  Fixed Cost إدخال التكاليف الثابتة 6-12

 هناك بعض التكاليف الثابتة فى المشروعات التى لا تتأثر بوقت تنفيذ  المهمة غالبا ما تكون

ریف اأو مده التنفيذ وهذه التكاليف مثل ثمن بعض المواد و ثمن المواصلات و مص

  GANTT یوضح واجة 3-6الشكل  .الفحوصات حيث یتم إدخالها مباشرة آتكاليف ثابتة

تكاليف  مع قائمة  Resource Sheet  یوضح واجة4-6و الشكل  .مع قائمة التكاليف الثابتة

  .الموارد

 :نتبع الاتيولإدخال التكاليف الثابتة  .

   Costومنه نختار  Table  نختار الأمر   view من قائمه  

یظهر عدد من أعمده تكاليف المشروع حيث یتم إدخال تكاليف الموارد أمام المهام  

  .آتكاليف ثابتة

   

 

  .  مع قائمة التكاليف الثابتةGANTTواجة : 3-6الشكل 
   

  

  . الموارد  مع قائمة تكاليفResource Sheetواجة : 4-6الشكل 
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 Contouring Assignment العمل مع الكنتور 6-13

رق ان طریقة توزیع المورد خلال فترة العمل یعتمد على التوزیع الكونتوري حيث یوجد عدة ط

 حيث یتم  Flat هو الكونتور المسطح Defaultفتراضيللتوزیع و عادة ما یكون التوزیع الا

  . ساعات یوميا8توزیع المورد بالتساوي على الفترة الزمنية بمعدل 

  .ان الخيارات الاخرى الموجودة تقوم بتعدیل التوزیع حسب الرغبة

  .Assignment Information  الامر Project اختر من القائمة 

  .و اختر نوع الكونتور work contour ثم ضع المؤشر على general اختر التبویب 

  

  

  تخصيص معلومات المهمة مع قائمة خيارات الكونتور:  5-6الشكل          
  

   أنواع دوال الكنتور6-14

 .علي المهمة خلال المدةیوجد ثمانية توزیعات احصائية مبنية داخل البرنامج لتوزیع ساعات العمل 

  یوضح المربع الحواري الخاص بتخصيص معلومات المهمة مع قائمة خيارات5-6و الشكل 

 وذلك یعني ان ساعات Flat و الامر الافتراضي في البرنامج هو التوزیع المستوي .الكونتور

  . ساعات في اليوم8العمل موزعة باتساوي على الایام و ذلك بمعدل 

تلاف او عدم تساوي ساعات العمل على مدى مدة المهمة، یتم اختيار نوع التوزیع في حل وجود اخ

  :المناسب من بين الانواع الاتية
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   على آامل المدةواو هو الكنتور الافتراضي و یكون على شكل مست      Flat) (المسطح   

   هناك ذروه في آمية العمل في نهایة التكليف(Back-loaded)المحمل خلفا 

  هناك ذروه في آمية العمل في بدایة التكليفFront-loaded) (حمل اماما لم 

  هناك ذروتين متميزتين یترآز فيهما العمل) Double Peak (ثنائي الذروة 

  مشابه للمحمل اماما مع تدرج باتجاه ذروة النشاط(Early Peak)الذروة المبكرة  

 ا مع تدرج باتجاه ذروة النشاطمشابه للمحمل خلف  (Late peak )  لذروة المتأخرة ا

    هنال ذروة وحيدة في منتصف النشاطBell)(  الجرس

 شبيه بالجرس مع تدرج نحو الحوافTurtle)  (السلحفاة  
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  ظبط و تعدیل الجدولة. 7
  Overtime Workالعمل مع الوقت الإضافي  7-1

د من إدخال تكاليف الوقت قد تحتاج بعض المهام لاستخدام بعض الموارد وقتا إضافيا ولذلك لاب

 -:ولإدخال عدد ساعات العمل الإضافي نتبع الأتى   .الإضافي ضمن تكاليف العمل

 .یجب الوقوف بالمؤشر أولا على المربع السفلى الخاص بالموارد ثم نختار الأمر

  .Resource Work  من ثم نختار    Details  نختار    Format  من قائمه  

ویتم إدخال عدد  ساعات   الحوارى التالى فى أسفل قائمه الإدخال حيث یظهر المربع    

 . یوضح طریقة تخصيص العمل الاضافي للمهمة5-6و الشكل  .العمل الإضافي

  

   تخصيص العمل الاضافي للمهمة : 1-7الشكل 
  
  

  :فهم التعامل مع الوقت الاضافي 7-2

 یمثل آمية (work)تها للجهد الخاص بالمهمة لان الجهد لن یتم اضافان آمية العمل الاضافي 

ان العمل الاضافي فقط یمثل جزء من العمل قيمة العمل الكلي و التي سوف یتم . العمل الاجمالية

  .عند ادخال قيمة عمل اضافي فان الفترة الزمنية للمهمة سوف تقل. حسابها بعدل تكلفة اضافية

 ساعات یوميا و ساعتين عمل اضافي 8ساعة و ذلك بعدل  40عندما یعمل شخص ما مدة : مثال

آما ان . د ساعتين من العشرة آعمل اضافي  ساعات عمل یومية و یتم تحدی10فان یجب تعيين 

  .العمل سوف یتم تنفيذه في اربعة ایام و ليس في خمسة ایام
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    Resource over allocation Leveling   الموارد تعارضاتتسویة 7-3

جة لمورد معين خلال فترة معينة عن اقصي عدد ازید الحتالتعارضات في الموارد عندما تحدث 

اذا تم جدولة مورد ليعمل على مهام متعددة فانه من المحتمل لهذا المورد ان . مترفر من هذا المورد

. في آل منظر فان التعارضات تظهر باللون الحمر.  هذه المهامفي استخدامه عندیحدث له تعارض 

  .في قائمة الموارد فانه یظهر تحذیر بذلك في الهوامش

 Locating the over allocations Task       تحدید المهام المحملة تحميلا زائد7-4

   Resource Graph المنظر Viewاختر من قائمة  

  split الامر Windowاختر من قائمة  

فأره سوف  و اضغط على الزر الایمن للResource Graphضع المؤشر على  

  یظهر لك عدة خيارات

  Over allocationاحتر  

  و ذلك باستخدامways to resolve over allocations جرب باختبار 

 To delay a task  

 Split a task  

 Assign additional or different resources  

  ازالة التعارضات بتجزئة او تأخير تنفيذ المهمة7-5

  رضات الخيارات المتاحة لازالة التعا

  تجزئة المهمة 

  تأخير تنفيذ المهمة 

  اضافة موارد 

  العمل وقت اضافي 

  :و القواعد العامة المتبعة لتحدید ذلك هي على الترتيب

  الوقت المتاح 

  اولویة تنفيذ المهام 

  الروابط و القيود 

   .IDرقم المهمة  

  .تاریخ التنفيذ 
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 ازالة التعارضات تطبيق  7-6

  اختر اي مهمة  

   Resource Leveling الامر Tools مةاختر من القائ 

  من المربع الحواري Level From/To الامر اختر 

  اختر من التقویم التواریخ التي ترغب بينها في ازالة التعارضات 

  یتم تسویة التعارضات حسب الخيارات التالية

  المهمة ذات الترقيم الاآبر تأخر اولا : 1طریقة رقم 

ة القياسية المفترضة في البرنامج و التي تسير وفق القواعد استخدام الطریق : 2طریقة رقم 

  :التالية

  المهام التى لا ترتبط بمهام لاحقة تؤخر اولا .1

 ثم تؤخر المهام التي لا تقع على المسار الحرج .2

 ثم المهام ذات الاولویة الدنيا و بدون قيود .3

 المهام ذات البدایات المتأخرة یتاح لها البدأ متأخرا .4

 استخدام الطریقة القياسية مع اخذ الاولویة في الاعتبار و التي تسير وفق القواعد  :3طریقة رقم 

  :التالية

  .و هنا تكون الاولویة هي العامل الذي یتحكم في تاخير المهام ذات الاولویة الادنى

  استخدم طریقتك الخاصة لتسویة الموارد وذلك آما یلي : 4طریقة رقم 

     Resource Allocation اختر ثم  More Views الامر View اختر من القائمة 

  من المربع السفلى Gantt Chart اختر 

 Table > More Tables الامرView   اختر من القائمة 

 Apply اختر ثم Delay الامر اختر 

 اضغط بالزر الایمن للفأرة علي Resource Usage Table في المربع العلوى 

Work Column. 

 Insert Column اختر 

 Assignment Delay Column اختر 

  Ok اختر 

  اذا اردت ادخال تأخير على تنقيذ المهمة

  اختر اى مورد مخصص للمهمة ترید تأخيره 

  .تأخيرها في المربع السفلي لاضافة المدة التى ترید Leveling Delay Field   اختر 
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  Automatic Levelingالتسویة الالية  7-7
رد تباعا حال ا سوف یقوم بتعدیل المهام و بتسویة الموالبرنامج فإن اذا اخترت التسویة التلقائية

و . ادخالها و هو سوف یقوم باحد خيارین اما تمدید المهمة او تقطيعها مما یسبب زیادة المدة الزمنية

  . استحدام التسویة الالية في المشاریع الكبيرة یبطئ التخطيط

Tools  Resource Leveling   Automatic 

  Bars Format  شكل مخطط المستقيمات 7-8
Format   Time scale                

Format   Bar   Categories  

Format   Setting   Styles 

Right Click on mouse   Bar Style 

  

 

 المقياس الزمني لوحدة الزمن : 2-7الشكل 
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  تغيير شكل المستقيمات   :3-7الشكل 
 

  Gridlines    الاسطر و الاعمدهتخطيط 7-9
Format   Gridlines  

Right click on the lines 

   Layout Barsشكل العلاقات  7-10 
Format  Layout  

  

  تغيير شكل الروابط : 4-7الشكل 
  

  Add more tables  اضافة جداول جدیدة 7-11

 View  table  more tables 



 MS PROJECT                                                                                                                         إدارة المشروعات   

 44

 

   Project Tracking  المشروعإدارة تتبع. 8
  Saving A Baseline حفظ المخطط الاساسي  8-1

هي امكانية عمل متابعة و ان من اعظم ميزات استخدام التقنيات الحدیثة في ادارة المشروعات 

 یتم حفظ ان اول خطوات التتبع ان. تحكم في سير عمل المشروعات بطریقة سهلة و سریعة

لية مالمشروع الاساسي و الذي سوف یستخدم آأساس للمقارنة حال بدأ العمل في المشروع و بدأ ع

حفظ ان لا یتم  لاحظ  انه یجب . حفظ المشروع الاساسيیوضح مربع حوار 1-8الشكل  .التتبع

د زمنية المشروع الاساسي الا بعد التيقن من استكمال ادخال آامل عناصر المشروع من مهام و مد

  : نتبع الاتيو لحفظ المشروع الاساسي . و ازالة التعارضات بين المواردو موارد

   Tracking اختر الامر Toolsمن القائمة  

  Save baselineمن القائمة المنسدلة اختر الامر  

  و ذلك لحفظ آامل المشروع آمشروع اساسي Entire Project اختر ایضا الامر 

   ملاحظة

ها و ذلك لامكان  الاساسي ، احتفظ بنسخة اخرى من الخطة قبل حفظقبل حفظ المشروع

  .استخدامها حال حدوث تغيير آبير على الخطة قبل بدأ التنفيذ

  

  

  حفظ المشروع الاساسي : 1-8الشكل 
  

  القاعدیة/عرض الخطة الاساسية 8-2
  :لعرض الخطة الاساسية اتبع الاتي

 GANTT Tracking ر المنظراخت View من القائمة 

   .Baseline اختر ثم  Table>More Tables اختر View من القائمة 
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القاعدة و العلوي یمثل المهمة الجاري /یمثل السفلي خط الاساسي) قظيبين(یشكل العرض خطين 

  .هي قابلة للتعدیل بينما الخط الاساسي لا یتغير و لا یمكن تعدیله تتبعها و

  لاساسيةتحریر الخطة ا 8-3
عند اجراء تحدیث علي بيانات الخطة الاساسية او اضافة بعض البنود اليها قم باتباع الخطوات 

  :التالية

   .GANTT المعدلة في جدول ادخال/اختر المهام المضافة 

   .Save baseline الامر Tools>Tracking إختر من القائمة 

   .OK ثم اختر Selected Tasks انقر على زر المهام المحدد 

   الخطة الاساسية مسح8-4 
  :لالغاء و مسح الخطة الاساسية

 Tools >Tracking > Clear Baseline اختر الامر 

   .OK اختر  

 Interim Plans  تتبع خطط مؤقتة8-5

خلال سير العمل بالمشروع قد ترغب بحفظ خطة مؤقتة و تتضمن تغييرات على تواریخ بدأ 

  :ظ حتى عشرة خطط مؤقتة آما یليو انتهاء المهام الحالية و یمكن حف

  .Save baseline الامر Tools>Tracking إختر من القائمة 

 save interim plan اختر 

  .Start/Finish حدد الحقول ، copy من اللائحة المنسدلة 

  .Start1/Finish1 حدد Into في مكان 

 .حدد ما اذا آنت ترید حفظ خطة مؤقتة لكل للمشروع او لجزء منه 

  .OK انقر 

   عرض خطة مؤقتة8-6
   .GANTT Tracking افتح العرض 

   .Start1 / Finish 1 اضف اعمدة 

   .OK انفر 

  Tracking متابعةالتقدم  8-7
 ان الخطوة التالية هي السير قدما مع تقدم العمل في المشروع یوما بيوم و تزوید البرنامج بخط 

  . خطة المشروع عن واقع التنفيذالسيرالعملي للمشروع و متابعة مدى توافق او انحراف

Tools Tracking   Update task 
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More tables  Task form details 

 

  تتبع و تحدیث مهام المشروع  : 2-8الشكل 
  

  

  تتبع المهام مع حفظ حخط القاعدة للمشروع  : 3-8الشكل 
  

  Up date Project  تحدیث المشروع آكل  8-8
آثيرا ما یكون المشروع بكامل فعالياتة التي لم یتم انجازها بعد بحاجة الي تحدیث و ذلك في احوال 

  .توقف المشروع لعذر قاهر مدة من الزمن

  :لتحدیث المشروع آكل 

Tools  Tracking   Update project 
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  مربع حواري تحدیث المشروع : 4-8الشكل 
  
  

  Progress line  خط التقدم  8-9
ان خطوط التقدم هي احدي وسائل عرض و تتيع المشروع اثناء تقدم العمل و یساعد ذلك بتحدید و 

ليات المتأخرة عن ابشكل فوري و سریع  وضع الفعاليات عند تاریخ محدد حيث یتم متابعة الفع
  الخطة عند زمن معين و محاولة تدارك ذلك 

Tools   Tracking   Progress line 

  

  مربع حواري خطوط التقدم للمشروع : 5-8الشكل 
  

  Optionsضبط خيارات المشروع  8-10
ان ضبط خيارات المشروع هي من اهم الخيارات التي علي المخطط تحدیدها من اجل اظهار 

ویم وساعات العمل و نوع المعلومات بالشكل المناسب و عمل التغييرات في الوحدات و الایام والتق
العملة المتداولة و و یفضل المخطط ان یقوم بهذة التغييرات عند بدایة عملة في اي مشروع جدید 

و لاجراء هذة التغييرات یتم . وان تتناسب الخيارات امعدلة من نوع و حجم و مدة المشروع
  : ااستخدام الامر

  
Tools  Options  

  خيارات المشروعب  الخص ريحواالمربع یوضح ال 6-8و الشكل 
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  مربع حواري خيارات المشروع : 6-8الشكل 
 

 Filters   المرشحات 8-6

. ستعلام حول المهام او المواردالایمكن استخام المرشحات لعمل تصفية للمعلومات او     

Project  Filtered for  More filter  Option 

 بالضغط على زر التصفية التلقائية في شریط Auto filter ية التلقائية و یمكن استخدام التصف

  .الادوات 
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  Printing  الطباعة . 9
یجب عمل تجهيز لصفحة الطباعة و خاصة في تحدید عنوان المشروع و قبل اجراء عملية الطباعة 

الاستشاري و تحدید اى معلومات یجب ان تظهر في عنوان الجدول مثل اسم المالك و المتبرع و 
 باستخدام ضبط الطباعة للمشروعحيث یمكن 1-9یظهر بالشكل رقم المشروع و آل ذلك آما 

   :الامر
 File  Page setup 

  

  

  مربع حواري خيارات ضبط الطباعة للمشروع : 1-9الشكل  
  

File  Print Preview 

File  Print  

  

  مربع حواري خيارات الطباعة المشروع  :2-9الشكل 
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  Insert Object/Picture  ادخال الصور  9-1 
صور او شعارات لمؤسسة او هيئة على عنوان الجدول و یمكن عمل احيانا یتطلب الامر ادخال 

  3-9لشكل یظهر باذلك آما 
Insert   Object   File  get picture from art clip 

Objects to header or footer 

Page setup  insert picture 

Insert object Microsoft clip Gallery 

  

  مربع حواري خيارات ادراج الصورة الى عنوان المشروع : 3-9الشكل 
 

Add picture to bars  

  

 Reports  التقاریر 9-2

یر عدیدة و متنوعة و هى تلزم اثناء ان من اآبر فوائد استخدام البرنامج هو قدرتة على انتاج تقار

  :تقدم العمل و في نهایة المشروع حيث یمكن الحصول على التقاریر التالية

Overview  : معلومات عامة عن المشروع  

Current activities :معلومات تفصيلية عن الانشطة المشكلة للمشروع  

 Costs : معلومات تفصيلية عن تكلفة للمشروع  

Assighments :معلومات عن الموارد المخصة للانشطة  

Workload : معلومات عن ساعات العمل و استغلال الموارد قي المشروع 
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View    reports  

  

  المشروعتقاریر مربع حواري خيارات  : 4-9الشكل 
 

  Save As Excel Form  حفظ الملف على صورة أآسل 9-3 

Save as    Microsoft Excel  Workbook 

 

  

 Excel الي المشروعحفظ مربع حواري خيارات  : 5-9الشكل 
 

Save  Export format  earned value 

Analysis by excel 

View  Tool bars  analysis  

Analysis timescale Date in Excel 

Pivot tables  
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Save as  Microsoft excel  pivot table  

Save  Export format  Task and resource pivot table 

  Import Excel File  استيراد ملف اآسل الى مایكروسوفت بروجكت 9-4

Open excel file  file type  Microsoft excel work book look in  select 

the work book you need to import 

  

  

  

  

  

  

  



 MS PROJECT                                                                                                                         إدارة المشروعات   

 53

Project 2 

Project description: 

The table 1 indicating the tasks of the project, duration and its relations and 

constraint   

The table 2 indicating the tasks of the project, resources and material costs 

 The table 3 indicating the persons and equipment costs 

Conditions 

Starting date of the project is 10/10/03 

The time period is 5 days. 

The trainer is working one overtime hour every day 

Required: 

Establish a Bar chart diagram. 

Establish logical relation ships 

Assign the needed resources for each activity 

Calculate the cost estimate for the project 

  

Table 1: Activities and relationships 
Duration Type of relation Depends on  Activity No.  

1 day ----  ----  Introduction 1 

1 day FS Introduction MS project 2  

1day  FS  MS project Data entry 3 

2day FS 

SS 

MS project 

Data entry 

Logical 

relations 

4 

1 day FF Logical 

relations 

Constraints 5 

1 day FS  Constraints Improvement 6 
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Table 2 : Resources, Equipments and Material cost   
Material cost 

$ 

Equipments Resources Activity No.  

200 (10) Computers, (1) LCD  Trainer, Project 

Manager 

Cad operator , 

Facilitator 

Introduction 1 

20 (10) Computers, (1) LCD  Trainer ,Cad operator MS project 2  

20  (10) Computers, (1) LCD  Trainer , Cad operator Data entry 3 

20 (10) Computers, (1) LCD  Trainer, Cad operator Logical 

relations 

4 

20 (10) Computers ,(1) LCD Trainer , Cad operator Constraints 5 

300 (10) Computers, (1) LCD  Trainer, Project 

Manager  

Cad operator, 

Facilitator  

Improvement 6 

 

Table 3: Standard and Overtime rates  
Overtime rate 

$ 

Standard rate $ Description No.  

30$/hr. 20$/hr. Trainer 1 

10$/hr. 7$/hr. Cad Operator   2  

45$/hr.  30$/hr.  Project manager 3 

6$/hr. 4$/hr. Facilitator 4 

-- 2$/hr Computer 5 

---  4$/hr  LCD 6 
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Project 3 

  

Project description: 

Attached is CPM diagram indicating the logical relation ships between the 

activities? The table 1 indicating the constraint table for resources 

distribution. 

Table 2 explains the regular and over time rates. 

Conditions 

The engineer is working every day two overtime working hours. 

Starting date of the project is 10/10/03 

The available resources are limited. 

Material price for activity should be dealt with as fixed price. 

Required  

Establish a Bar chart diagram for the problem below. 

Assign the needed resources for each activity 

Calculate the cost estimate for the project 

 

Table 1: Equipments and Material costs 
Material cost $ Equipments Description Activity No.  

200 Drill, Saw Engineer  (1No.), Mechanic 

(2No.)  

A 1 

3000 Voltmeter Engineer  (1No.), 

Electric    (2No.) 

B 2  

500  Hammer  Engineer  (1No.), Foreman  

(1No.) 

C 3 

 Drill Engineer  (1No.), Mechanic 

(1No.) 

D 4 

 Drill, Voltmeter Engineer  (1No.), Mechanic 

(1No.), Electric    (1No.) 

E 5 

  Hammer  Engineer  (1No.), Foreman  

(1No.) 

F 6 
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Table 2: Standard and Overtime rates 

Overtime rate 

$ 

Standard rate $ Description No.  

15$/hr. 10$/hr. Engineer 1 

10$/hr. 7$/hr. Mechanic 2  

7$/hr.  5$/hr.  Electric 3 

6$/hr.  4$/hr.  Foreman 4 

 

 

  
  


